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Introduction 

The Event Capture Graphical User Interface (GUI) User Manual provides instructions for using 
the Event Capture options within the GUI setting. The target audience for this manual includes 
Event Capture managers, application coordinators (ADPACs), and others who use the software. 

The Event Capture GUI software provides a consistent, event driven, windows style, user 
interface for Event Capture. The GUI captures all the utilization data that is presently available 
in Event Capture. 

The Event Capture GUI software provides a mechanism to track and account for procedures and 
delivered services that are not handled in any other VistA package. The procedures and services 
tracked through Event Capture are associated with the following: 

•	 The patient to whom they were delivered 
•	 The provider requesting the service or procedure 
•	 The DSS Unit responsible for delivering the service 

DSS Units typically represent the smallest identifiable work unit in a clinical service at a medical 
center and are defined by the VAMCs. A DSS Unit can represent any of the following: 

•	 An entire service 
•	 A section of a service 
•	 A small section within a section 
•	 A medical equipment item used in patient procedures 

For every DSS Unit, each of the following must be defined: 

•	 Service - The service associated with the DSS Unit. 
•	 Cost Center - Fiscal identifier for the service using the particular DSS Unit (Cost Centers are 

defined in detail in the MP4-Part V Appendix B of the Fiscal Service cost manuals.)  
•	 Medical Specialty - The specialty section associated with the DSS Unit. 

Sensitive Information 

To avoid displaying sensitive information regarding our patients and staff, the examples in this 
manual contain pseudonyms or scrambled data instead of real names. Our patients and staff will 
be referred to as “ECPATIENT, ONE”, “ECPROVIDER, ONE”, or “USER, ONE.” Scrambled 
data is a series of random letters that replace a real name like “AAADY, JWHTRE”. Likewise, 
real social security numbers (SSNs), real addresses, and other personal identifiers are not used.  
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Introduction 

508 Compliant GUI 

Section 508 of the Rehabilitation Act Amendments of 1998 requires that when Federal agencies 
develop, procure, maintain, or use electronic and information technology, they shall ensure that 
the electronic and information technology allows persons with disabilities to have access to, and 
use of, information and data that is comparable to the access to and use of information and data 
by persons who are not individuals with disabilities, unless an undue burden would be imposed 
on the agency. 

The Section 508 Accessibility Testing and Training Center (T&TC) was consulted and 
modifications to the GUI have been made to meet the requirements for 508 Compliance. The 
Event Capture GUI has been modified to allow screen readers, used by the visually impaired, to 
accurately interpret information on the screens. As a result, some buttons and boxes have been 
moved, replaced, or renamed and some screen titles have been modified.  

For more information on the VA 508 Compliance efforts, please visit the following website 
http://www.va.gov/oit/ea/section508/ . 

Related Manuals 

The documentation for Event Capture V. 2.0 includes the following related manuals. 

• Event Capture Monograph 
• Event Capture V 2.0 User Manual 
• Event Capture V2.0 Installation Guide 
• Event Capture V 2.0 Technical Manual 
• Event Capture GUI Release Notes 

These documents can be found at  
http://www.va.gov/vdl/application.asp?appid=39 
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Introduction 

Event Capture Online Documentation 

Instructions / Help 

Throughout the entire ECS package, you may click on the question mark (?) in the GUI options 
located at the toolbar or on the bottom right corner of the screen to obtain on-line information for 
any screen. This help corresponds with what is in the User Manual. 

You may also click on a field and then press F1 to obtain on-line information for that field. 

Example 
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Introduction 

Event Capture GUI Interface with CPRS 

The Event Capture GUI system can be accessed via the Computerized Patient Record System 
(CPRS). This function was created to increase usability of ECS by clinicians currently using 
CPRS. A link and a single point of entry were created so users can access both systems.  

The interface between CPRS and ECS allows users to: 

•	 Access from within CPRS to ECS through a single sign-on 
•	 Select Event Capture Interface in the CPRS Tool Menu allowing the user to enter Event

Capture patient procedures. 

Timeout Feature 

The ECS GUI includes a timeout feature consistent with Computerized Patient Record System 
(CPRS). When the ECS GUI application is left unattended for a user-defined period of time, a 
countdown screen will be displayed, warning the user of the pending timeout of the application. 
If the user takes no action, the application will close. The period of time for the timeout and 
countdown features is user-defined at the application server level. Click on the “Do not close 
Event Capture” button to stay connected. 
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Orientation 

This manual is designed for use as an instructional guide to using the Event Capture Graphical 
User Interface software. It can be used in conjunction with the Event Capture GUI Online help 
option. 

Screen displays may vary among different sites and you may not see the data on the terminal 
exactly as shown in this manual. Although screens are subject to modification, the major menu 
options as they appear in this manual are fixed and are not subject to modification (except by the 
package developer). 

Online Help 

Help is available at almost any prompt in the GUI application. Entering the F1 key at a field will 
provide information to help the user answer the prompt.  

Frequently Asked Questions (FAQ) 

How can I access the Event Capture Graphical User Interface (GUI)? 
Users need a username and access code obtained from their local Information Resources 
Management (IRM) staff to use the Event Capture GUI. 

How do I logon to the Event Capture GUI ? 
The Event Capture GUI is usually accessed through a desktop shortcut which points to the 
installation location. Your local support staff can assist you. 

What other logon problems should I anticipate? 
If the Event Capture GUI is launched but disappears or is not responding, check your firewall, 
for example Black Ice. Make sure you list the IP address for the system with which you are 
communicating. Your local support staff can assist you. 

What can cause the GUI to appear distorted? Missing scrollbars? Missing columns or 
missing rows? 
The screen resolution on your computer needs to be set to 96 dots per inch (DPI). 
Follow the instructions below. 
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Orientation 

1) Right click on your desktop and select properties. 

2) Then select Settings and Click on the Advance Button. 

3) Select Normal Size (96 DPI) from the DPI Setting box, then click OK. 
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Before Using the Software 

Before you attempt to enter Event Capture data, you must set-up Event Capture by using the 
options in the Event Capture Management Menu. Access to this menu should be restricted to the 
application coordinator (ADPAC) and his or her designees. The Event Capture ADPAC should 
use the following steps as a guide for setting up the Event Capture software. 

1. 	 Use the Location - Update Location Information option to create an Event Capture location. 

Notes 
•	 No further options are functional until an Event Capture location is created. 
•	 The selected location must be in the INSTITUTION file (#4). 
•	 A location must be created with this option before DSS Units can be established. 

2. 	 Contact each service for a list of its DSS Units, the names of its Event Capture users, and the 
DSS Units for which they will enter data, and for individual product resource tracking needs. 
Use the DSS Unit - Add or Update DSS Units option to establish DSS Units for each service. 

Note: 
•	 No further options are functional until the DSS Units are created. 

3. 	 Use the Access by User - Grant Access to DSS Units by User option to assign user access to 
specific DSS Units for the users identified in Step 2. Assign the ECALLU security key only 
to those users who should have access to all DSS units. 

Notes 
•	 Users must have access to DSS Units before they can begin entering data. 
•	 Use the Access by User – Grant Access to DSS Units by User option to remove user 

access for a specific DSS Unit, except for those users who have the ECALLU security 
key, which overrides user access removal. 

4. 	 Use the Category - Add or Update Categories option to create local categories before the 
user sets up Event Code screens. Creating local categories is optional. 

Helpful Hint 
•	 After completion of this step, the Category Report option on the Reports Menu can be 

used to print a report of the site’s local categories. 
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Before Using the Software 

5. 	 Use the Procedure - Add or Update Local Procedures option to enter new or edit existing 
local procedures to the EC NATIONAL PROCEDURE file (#725). Adding local procedures 
is optional. 

Helpful Hint 
•	 Before starting this step, use the National/Local Procedure Report option on the Reports 

Menu to print a list of procedures with their associated CPT codes. This report can be 
quite lengthy if it includes national procedures, so it should be queued to print to a device 
during non-peak hours. 

Notes 
•	 You must enter an associated CPT code to pass local procedures to PCE. 
•	 Use this option to edit, but not delete, existing local procedures and to select an 


associated CPT code if your site wants this workload data sent to PCE. 


6. 	 Use the Event Code Screen - Add or Update Event Code Screens option to: 
•	 Create an event code screen for each procedure tracked in the Event Capture software. 
•	 Enter or edit an active associated clinic for DSS Units that are marked to send data to 

PCE. If an Associated Clinic has non-conforming stop codes, the clinic will not be 
selectable. 

•	 Enter or edit a procedure synonym. 
•	 Enter or edit a procedure reason. 
•	 Enter or edit procedure default volume. 

Note: 
•	 You must create a screen for the procedure before it can be used for data entry. 

7. 	 Use the Print Category and Procedure Summary (Report) option on the Reports Menu to 
print the Event Code screens sorted by DSS Units. 

Helpful Hint 
•	 Data entry clerks might find the output generated by this report useful as a procedure 

reference guide. 

8. 	 Set up of Event Capture V 2.0 GUI is complete. Services can now enter data using the Data 
Entry options and provide summary reports using the Reports options. 
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Logon 

The Event Capture GUI is usually accessed through a desktop shortcut which points to the 
installation location. Your local support staff can assist you. 

ECS GUI.lnk 

You will then view the VistA Sign-on screen. Enter your VistA Access Code and Verify Code. 
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Event Capture Main Menu 

The Event Capture software contains four menus. The user must hold the appropriate security 
keys to have access to the Spreadsheet Menu and to the Management Menu and their options. 

This manual is organized by options of the software. The name that appears on each option 
button corresponds with a section in this manual. 

You will see the Main Menu options when the Event Capture GUI opens. 
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Event Capture Main Menu 

ICON shortcuts may also be used to access options. 

Menu Bar 

The Event Capture menu bar allows you to access shortcut commands. The File Menu allows 
you to Exit the window. The View Menu allows you to show or hide the Toolbar and Status Bar. 
The Function Menu on the Main window provides access to Data Entry, Spreadsheet, Reports, 
and Management Menu functions. The Table Menu on the Management Menu Screen gives 
access to the Location, DSS Unit, Access by User, Category, Procedure, and Event Code Screen 
tables. 

Main Menu Bar 

Main Menu Bar with Menus Expanded 
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Event Capture Main Menu 

Management Menu Bar 

Maintenance Menu Bar with Menus Expanded 

Default Location to all Enter/Edit Screens 

On all Event Capture screens, the previous Location entry will be “saved” and used as the 
default on subsequent Location fields. 

DSS Unit List with Secondary Associated Stop Codes option 

The Event Capture software restricts DSS-Only workload to use valid stop codes only. To assist 
sites in locating DSS Units that have invalid associated stop codes, the DSS Unit List with 
Secondary Associated Stop Codes option is provided. It may be attached as a secondary menu 
option and run as often as needed. The only prompt is for Device.  

Example of the output from this option. 

DSS UNITS WITH ANY ASSOCIATED STOP CODE ERRORS PAGE: 1 

DSS UNIT: 46 18Z1 CHAPLAIN I/P
STOP CODE: 110 ADMITTING/SCREENING
REASON: INACTIVE CODE 
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Event Capture Main Menu 
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Data Entry Menu 

Enter patient and procedure data 

The Data Entry Menu offers the following options. 

• Data Entry by Patient – Enter/Edit Patient Procedures 
• Data Entry by Procedure – Batch (Same Procedure, Multiple Procedures) 
• Multiple Dates/Procs – Multiple Dates / Multiple Procedures 
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Data Entry Menu 
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Data Entry by Patient 

Enter / Edit Patient Procedures for a single patient 

Before the User Starts 

•	 Use this option to: 
o	 Enter a single procedure for one patient. 
o	 Enter multiple procedures for one patient. 
o	 Edit an existing patient procedure. 
o	 Delete an existing patient procedure. 

•	 Event Code screens must be defined before entering any Event Capture data. 

What the User will see 

•	 A Summary screen identifying the Location, DSS Unit, Procedure Date Range, Patient and 
the Procedures for that patient. 

•	 A Detail screen showing detailed information about a selected procedure. 
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Data Entry by Patient 

Summary Screen 

Instructions 

1.	 Select a Location. 
•	 If one location is defined in the VistA security set-up, Location will default to that value. 
•	 If more than one location is defined, no default will be assigned. Choose a location from 

a drop-down list of available locations based on your VistA security sign-on. 
2.	 Select a DSS Unit. 
•	 If one DSS Unit is defined in the Event Capture Management set-up for DSS Unit, DSS 

Unit will default to that value. 
•	 If more than one DSS Unit is defined, no default will be assigned. Choose a DSS Unit 

from a drop down list of DSS Units to which you have access. 
•	 You can add, edit, or delete any patient procedure for the selected DSS Unit. 
•	 To gain access to a DSS Unit, use the Management Menu > DSS Unit - Add or Update 

DSS Units function to add the unit to the dropdown list. 

Event Capture V. 2.0 GUI User Manual	 January 2010 18 



  

 

 
 

 
 

 
 

 
 

 

 
 

 
 
 

Data Entry by Patient 

3.	 Select a Procedure Date range (from/to).   
•	 The Procedure Date Range (from/to) will default to the system date. You may edit these 

fields by typing in a date (dd mmm yyyy) or by using the calendar dropdown. An edit 
check will prevent selecting a date in the future or selecting a “from” date which is later 
than the “to” date. 

4.	 Use the Patient Identifier field to select a patient. 
•	 Enter one of the following: 

Patient Name (whole or partial, last name first) 
Social Security Number 
Last four digits of the Patient Social Security Number 
First character of Last Name plus the last four digits of Social Security Number 

•	 Click Search or the Enter key. 
•	 Choose from the list of patients displayed. 

5.	 Once you complete the above fields, the bottom section of the window will display (in 
descending chronological order) the Procedure History for the selected patient at the selected 
DSS Unit for the date range specified. The Procedure History will display the Category, 
Procedure, Date/Time, Volume, Associated Clinic, Ordering Section, Primary Diagnosis, and 
Primary Provider.  

6.	 The Add button at the bottom of the screen will now become active. 
7.	 Clicking the Add button will bring you to a Detail screen where you will add outpatient 

procedures for this patient and answer classification questions for the procedures and the 
patient. 

8.	 Clicking on a Procedure will highlight it and activate the Update and Delete buttons. 
9.	 Clicking the Update button will display the procedure on the Detail screen for editing. 
10. Clicking the Delete button will delete the procedure from the patient’s record.   

January 2010 	 Event Capture V. 2.0 GUI User Manual 19 



 

  

 
 

 
 

 
 

 
 

 
 

Data Entry by Patient 

Detail Screen 

Instructions 

1.	 Select a Category 
•	 If only one category is defined for the specified DSS Unit, it will default to that value. 
•	 If the Allow Category field in the Add DSS Unit Management set-up is set to NO, the 

Category field will be blank and disabled. 
2.	 Select the Procedure Date and Time by using the Select Date/Time popup window. 
•	 Typing “N” in the field instead of clicking the button will bypass the popup and enter the 

current system date and time.  
•	 Clicking “Now” on the popup will enter the current system date and time. 
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Data Entry by Patient 

3.	 Select an eligibility for this procedure. 
•	 If the selected patient has only one eligibility, it will default to that value; otherwise, 

select the eligibility that applies to this procedure. 
•	 The primary eligibility is displayed as the default. 

4.	 Select a Procedure. 
•	 Use the Procedure Name field to enter one of the following: 


Procedure name (whole or partial) 

Procedure Number 

CPT or National Number 

Synonym (preceded by the “&” character). 


•	 Select from the resulting dropdown list. 
•	 If only one procedure is defined for the specified category, Procedure will default to that 

value. 
5.	 Enter the Volume for the procedure. 
6.	 If applicable, the CPT Modifiers section will be activated. 
•	 If you entered a CPT code above or the procedure has an associated CPT code, then this 

section will display the available modifiers. Modifiers provide additional information 
about a CPT procedure. With functionality put in place by the Code Set Versioning 
project, only CPT modifiers that are active for the date and time of the event will be 
shown. 

•	 Choose a Modifier from the Available list and click Include. Repeat as needed. 
•	 To remove a modifier, choose it from the Selected list and click Exclude. 
•	 You can use CTL-Click to select multiple Modifiers at one time. 

7.	 If applicable, the Procedure Reason field will be activated. Choose a Reason from the 
dropdown list. 

8.	 If applicable, the “Mandatory” classification questions section will be activated. 
•	 Select YES only if the treatment received is related to that classification. 
•	 Selecting the F1 key while in the Service-Connected field will open a pop-up window 

displaying the patient’s service connection and any rated disabilities. 

January 2010 	 Event Capture V. 2.0 GUI User Manual 21 



 

  

 
 

 
 

 

 
 
 

 
 

 

  
  

 

 
 

 

 

 
 

 

Data Entry by Patient 

9.	 Select the Ordering Section. 
10. Select the associated ICD-9 diagnosis codes for the procedure. 
•	 Use the Primary field to enter one of the following: 


ICD-9 code (whole or partial) 

Diagnosis Name (whole or partial) 


•	 Press the Search button. 
•	 Select from the resulting dropdown list. 
•	 Repeat as needed to select the Secondary Diagnosis Codes. 

11. Select the Associated Clinic. 
12. Select the providers of the services. 
•	 Use the Providers Available text box to enter the following: 


Provider name (full or partial, last name first) 

•	 Select the provider from the resulting dropdown list and click Include. 
•	 To remove a provider, select from the Providers Selected list and click Remove. 

13. Click the Add button to save the edited procedure and display a blank Detail screen ready for 
another entry. 

14. Click the OK button to save the edited procedure and return to the Summary screen. 
15. Click the Cancel button to return to the Summary screen without saving the above entries. 

Notes 
•	 If the event is to be sent to PCE based on the DSS Unit Management set-up, then all 

fields will be required. 
•	 If the event is not to be sent to PCE based on the DSS Unit Management setup, then the 

Associated Clinic and the four Secondary Diagnosis fields will be disabled. 
•	 Selecting F1 while in any field opens a pop-up window displaying a Help message. 
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Data Entry by Patient 

Add a Patient Procedure 

The following instructions and example assume that the user is entering a new procedure for a 
specified patient and wants the specified DSS Unit to send data to PCE. 

Instructions 

To Add a Patient Procedure 

1. On the Main Menu, select Data Entry. 
2. On the Data Entry Menu, select Entry by Patient. 
3. View the Summary screen. 

Summary Screen 

4. Select the Location and DSS Unit. 
5. Allow Procedure Date Range to default to today. 
6. Select a patient. 
7. Click Add. 
8. A Detail screen will appear. 
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Data Entry by Patient 

Add a Patient Procedure 

Detail Screen 

9.	 Complete the procedure related fields on the Detail screen according to the field by field 
instructions given earlier. 

10. Click Add to save the Detail entries and open another Detail screen for this patient. 
11. Click OK to save the Detail entries and return to the Summary screen. 
12. The Summary screen will now display the procedures entered for this patient. 
13. Click Close on the Summary screen to save the new patient and return to the Data Entry 

Menu. 
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Data Entry by Patient 

Add a Patient Procedure 

Summary Screen after Adding Procedures 
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Data Entry by Patient 

Edit a Patient Procedure 

To edit an existing patient procedure 

1.	 On the Main Menu, select Data Entry. 
2.	 On the Data Entry Menu, select Entry by Patient. 
3.	 View the Summary screen. 

Summary Screen 

4.	 Select the Location and DSS Unit. 
5.	 Enter a Procedure Date Range by using the calendar dropdowns. Default is today. 
6.	 Select a patient. 
7.	 The lower portion of the screen will now display the procedures for this patient and this DSS 

Unit within this time frame. 
8.	 Choose a procedure and click Update. 
9.	 A Detail screen will appear. 
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Data Entry by Patient 

Edit a Patient Procedure 

Detail Screen 

10. Complete the procedure related fields on the Detail screen according to the field by field 
instructions given earlier. 

11. Click Add to save the Detail entries and open another Detail screen for this patient. 
12. Click OK to save the Detail entries and return to the Summary screen. 
13. The Summary screen will now display the procedures entered for this patient. 
14. Click Close on the Summary screen to return to the Data Entry Menu. 
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Data Entry by Patient 

Delete a Patient Procedure 

To delete an existing patient procedure 

1.	 On the Main Menu, select Data Entry. 
2.	 On the Data Entry Menu, select Entry by Patient. 
3.	 View the Summary screen. 

4.	 Select the Location and DSS Unit. 
5.	 Enter a Procedure Date Range by using the calendar dropdowns. Default is today. 
6.	 Select a patient. 
7.	 The lower portion of the screen will now display the procedures for this patient and this DSS 

Unit within this time frame. 
8.	 Choose a procedure and click Delete. 
9.	 View a confirmation message and click Yes or No. 
10. The screen will now refresh to show the remaining procedures entered for this patient. 
11. Click Close to return to the Data Entry Menu. 
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Data Entry by Procedure 

Enter / edit the same procedure for multiple patients 

Before the User Starts 

•	 Event Code screens must be defined before entering any Event Capture data. 
•	 Use the Data Entry by Patient option to make corrections to erroneous patient data. 

What the User will see 

•	 The left half of the screen identifies the procedure to be added to each patient’s record. You 
will complete this section once. 

•	 The right half of the screen identifies each patient. You will complete this section for each 
patient, pressing Add to get a refreshed screen for the next patient. 

•	 The View button will display a listing of all patients entered for this procedure in this session. 
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Data Entry by Procedure 

Add a Procedure (Multiple Patients) 

The following instructions and example assume that the user wants the specified DSS Unit to 
send data to PCE. 

Instructions 

1.	 Select a Location. 
•	 If one location is defined in the VistA security set-up, Location will default to that value. 
•	 If more than one location is defined, no default will be assigned. Choose a location from 

a drop-down list of available locations based on your VistA security sign-on. 
2.	 Select a DSS Unit. 
•	 If one DSS Unit is defined in the Event Capture Management set-up for DSS Unit, DSS 

Unit will default to that value. 
•	 If more than one DSS Unit is defined, no default will be assigned. Choose a DSS Unit 

from a drop down list of DSS Units to which you have access. 
•	 You can add, edit, or delete any patient procedure for the selected DSS Unit. 
•	 To gain access to a DSS Unit, use the Management Menu > DSS Unit - Add or Update 

DSS Units function to add the unit to the dropdown list. 
3.	 Select a Category. 
• If only one category is defined for the specified DSS Unit, it will default to that value. 

4.	 Select the Procedure Date and Time by using the Select Date/Time popup window. 
•	 Typing “N” in the field instead of clicking the button will bypass the popup and enter the 

current system date and time.  
•	 Clicking “Now” on the popup will enter the current system date and time. 
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Data Entry by Procedure 

Add a Procedure (Multiple Patients) 

5.	 Select a Procedure. 
•	 Use the Procedure Name field to enter one of the following: 


Procedure name (whole or partial) 

Procedure Number 

CPT or National Number 

Synonym (preceded by the “&” character). 


•	 Select from the resulting dropdown list. 
•	 If only one procedure is defined for the specified category, Procedure will default to that 

value. 
6.	 If applicable, the Procedure Reason field will be activated. Choose a Reason from the 

dropdown list. 
7.	 If applicable, the CPT Modifiers section will be activated. 
•	 If you entered a CPT code above or the procedure has an associated CPT code, then this 

section will display the available modifiers. Modifiers provide additional information 
about a CPT procedure. With functionality put in place by the Code Set Versioning 
project, only CPT modifiers that are active for the date and time of the event will be 
shown. 

•	 Choose a Modifier from the Available list and click Include. Repeat as needed 
•	 To remove a modifier, choose it from the Selected list and click Exclude. 
•	 You can use CTL-Click to select multiple Modifiers at one time. 

8.	 Select the providers of the services. 
•	 Use the Providers Available text box to enter one of the following: 


Provider name (full or partial, last name first) 

•	 Select the provider from the resulting dropdown list and click Include. 
•	 To remove a provider, select from the Providers Selected list and click Remove. 

9.	 Use the Patient Identifier field to select the first patient. 
•	 Enter one of the following: 

Patient Name (whole or partial, last name first) 
Social Security Number 
Last four digits of the Patient Social Security Number 
First character of Last Name plus the last four digits of Social Security Number 

•	 Click Search or the Enter key. 
•	 Choose from the list of patients displayed. 

10. Select this patient’s Eligibility for this procedure. 
•	 If the selected patient has only one eligibility, it will default to that value; otherwise, 

select the eligibility that applies to this procedure. 
•	 The primary eligibility is displayed as the default.   

11. Enter this patient’s Volume for this procedure. 
12. If applicable, the “Mandatory” classification questions section will be activated. 
•	 Select YES only if the treatment received by this patient is related to that classification. 
•	 Selecting the F1 key while in the Service-Connected field opens a pop-up window 

displaying the patient’s service connection and any rated disabilities. 

January 2010 	 Event Capture V. 2.0 GUI User Manual 31 



  

 

 
 

 
 
 

 

 
 
 

 

 

 

 

 
 

Data Entry by Procedure 

Add a Procedure (Multiple Patients) 

13. Select this patient’s Ordering Section. 
14. Select an Associated Clinic for the specified DSS Unit, if applicable. 
15. Select this patient’s associated ICD-9 diagnosis codes for the procedure. 
•	 Use the Primary field to enter one of the following: 


ICD-9 code (whole or partial) 

Diagnosis Name (whole or partial) 


•	 Press the Search button. 
•	 Select from the resulting dropdown list. 
•	 Repeat as needed to select the Secondary Diagnosis Codes. 

16. Click the Add button to add this procedure to the above patient’s records and redisplay the 
screen for entry of another patient. 

17. Select the next patient for whom you wish to enter this procedure. Repeat the patient related 
steps above. 

18. Click the OK button to add this procedure to the above patient’s records and return to the 
menu. 

19. Click the View button to verify that the list of patients you entered is correct. You will see the 
following screen. 
•	 The View Patients screen will list all patients entered for this procedure during this 

session. 
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Data Entry by Procedure 

Add a Procedure (Multiple Patients) 

20. To correct an entry, return to the Data Entry Menu and select Data Entry by Patient. 
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Multiple Dates / Procedures 

Add multiple dates and multiple patients for multiple procedures 

Before the User Starts 

•	 Event Code Screens must be defined before entering any Event Capture data. 
•	 Use the Data Entry by Patient - Enter/Edit Patient Procedure(s) option to make corrections to 

erroneous patient data. 

What the User Will See 
•	 A main screen for entering common fields and Procedure Dates. 
•	 Three tabs for entering providers, procedures and patients. 
•	 Two tabs for checking your work before submitting. 

Instructions 
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Multiple Dates / Procedures 

1.	 Select a Location. 
•	 If one location is defined in the VistA security set-up, Location will default to that value. 
•	 If more than one location is defined, no default will be assigned. Choose a location from 

a drop-down list of available locations based on your VistA security sign-on. 
2.	 Select a DSS Unit. 
•	 If one DSS Unit is defined in the Event Capture Management set-up for DSS Unit, DSS 

Unit will default to that value. 
•	 If more than one DSS Unit is defined, no default will be assigned. Choose a DSS Unit 

from a drop down list of DSS Units to which you have access. 
•	 You can add, edit, or delete any patient procedure for the selected DSS Unit. 
•	 To gain access to a DSS Unit, use the Management Menu > DSS Unit - Add or Update 

DSS Units function to add the unit to the dropdown list. 
3.	 Select a Category 
• If only one category is defined for the specified DSS Unit, it will default to that value. 

4.	 Select the Procedure Dates and Times by using the Select Date/Time popup window. 
•	 Typing “N” in the field instead of clicking the button will bypass the popup and enter the 

current system date and time.  
•	 Clicking “Now” on the popup will enter the current system date and time. 
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Multiple Dates / Procedures 

•	 Select a date and time and click OK to return to the main screen. 
•	 Click the Add Date/Time button to add the choice to the Selected Dates list. 
•	 Select and add additional dates as needed. 
•	 To remove a date, choose it from the list and click the Delete Date/Time button. 

5.	 Click and complete the tabs for Providers, Procedures and Select Patient as described below.   
6.	 Use the View Selected Patients and Records Pending Filing tabs to check your work as 

described below. 
7.	 Click the Add button at the bottom of the screen to process the transactions shown on the 

Records Pending Filing tab and then redisplay the screen initialized for a new set of entries.  
8.	 Click the OK button at the bottom of the screen to process the transactions shown on the 

Records Pending Filing tab and then return to the Data Entry Menu. 
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Multiple Dates / Procedures 

Providers Tab 

Instructions 

1. Click on the Providers tab to select one or more providers. 
2. Select a provider. 
•	 Use the Providers Available text box to enter the following: 


Provider name (full or partial, last name first) 

• Select the provider from the resulting dropdown list and click Include. 

3. To remove a provider, select from the Providers Selected list and click Remove. 
4. Repeat as needed to add additional providers. 
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Multiple Dates / Procedures 

Procedures Tab 

Instructions 

1.	 Click on the Procedures tab to select one or more procedures.  
2.	 Select a Procedure. 
•	 Use the Procedure Name field to enter one of the following: 


Procedure name (whole or partial) 

Procedure Number 

CPT or National Number 

Synonym (preceded by the “&” character). 


•	 Select from the resulting dropdown list. 
•	 If only one procedure is defined for the specified category, Procedure will default to that 

value. 
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Multiple Dates / Procedures 

3.	 If applicable, the CPT Modifiers section will be activated. 
•	 If you entered a CPT code above or the procedure has an associated CPT code, then this 

section will display the available modifiers. Modifiers provide additional information 
about a CPT procedure. With functionality put in place by the Code Set Versioning 
project, only CPT modifiers that are active for the date and time of the event will be 
shown. 

•	 Choose a Modifier from the Available list and click Include. Repeat as needed. 
•	 To remove a modifier, choose it from the Selected list and click Exclude. 
•	 You can use CTL-Click to select multiple Modifiers at one time. 

4.	 Enter the Volume for this procedure. 
5.	 If applicable, the Procedure Reason field will be activated. Choose a Reason from the drop-

down list. 
6.	 Click the Add Procedure button to add this procedure to the Selected Procedures list and 

display a blank screen ready for another entry. 
7.	 To add another procedure, repeat the steps above. 
8.	 To delete a procedure, choose it from the Selected Procedures list and click the Delete 

Procedure button. 
9.	 To view a procedure in an expanded format, choose it from the Selected Procedures list and 

click the View Details button. You will see the following screen. 

View Details Screen 
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Multiple Dates / Procedures 

10. This screen is display only. 
11. Click the Close Procedure View button to return to the Procedures tab. 
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Multiple Dates / Procedures 

Select Patient Tab 

Instructions 

1.	 Click on the Select Patient tab to select one or more patients. 
2.	 Use the Patient Identifier field to select a patient. 
•	 Enter one of the following: 

Patient Name (whole or partial, last name first) 
Social Security Number 
Last four digits of the Patient Social Security Number 
First character of Last Name plus the last four digits of Social Security Number 

•	 Click Search or the Enter key. 
•	 Choose from the list of patients displayed. 

3.	 Select an eligibility for this procedure. 
•	 If the selected patient has only one eligibility, it will default to that value; otherwise, 

select the eligibility that applies to this procedure. 
•	 The primary eligibility is displayed as the default. 
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Multiple Dates / Procedures 

4.	 If applicable, the “Mandatory” classification questions section will be activated. 
•	 Select YES only if the treatment received is related to that classification. 
•	 Selecting the F1 key while in the Service-Connected field will open a pop-up window 

displaying the patient’s service connection and any rated disabilities. 
5.	 Select the Ordering Section. 
6.	 Select the Associated Clinic. 
7.	 Select the associated ICD-9 diagnosis codes for the procedure. 
•	 Use the Primary field to enter one of the following: 


ICD-9 code (whole or partial) 

Diagnosis Name (whole or partial) 


•	 Press the Search button. 
•	 Select from the resulting dropdown list. 
•	 Repeat as needed to select the Secondary Diagnosis Codes. 

8.	 Click the Add Patient button to add this patient to the list of Selected Patients and display a 
blank screen ready for another entry. 

9.	 Use the View Selected Patients tab to check your work. 
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Multiple Dates / Procedures 

View Selected Patients Tab 

Instructions 

1.	 Click on the View Selected Patients tab to review the list of selected patients. 
2.	 To remove a patient from the list, select it and click the Delete Patient button. Click Yes on 

the Confirmation pop-up. 
3.	 To view a patient in an expanded format, choose it and click the View Details button. You 

will see the following screen. 
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Multiple Dates / Procedures 

View Patient Record Details Screen 

4. This screen is display only. 
5. Click the Close Patient View button to return to the View Selected Patients tab. 
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Multiple Dates / Procedures 

Records Pending Filing Tab 

Instructions 

1.	 Click on the Records Pending Filing tab to view a list of the records to be filed. 
2.	 This screen is display only. 
3.	 This screen lists the individual records (transactions) which will be processed when you click 

the Add button at the bottom of the screen. The records consist of every combination of the 
dates, procedures, and patients selected on the tabs described above. The providers you 
selected will be assigned to each record. 

4.	 Click the Add button at the bottom of the screen to file the records. 
5.	 To change the list, review and revise your selections on the Providers, Procedure and Select 

Patient tabs and for the Selected Dates/Times field. 
6.	 To correct an entry, return to the Data Entry Menu and select Data Entry by Patient. 
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Spreadsheet 

Enter Data via the Event Capture Spreadsheet 

Before The User Starts 

•	 The Spreadsheet screen in the ECS GUI application allows users to open an existing file 
containing their workload data and upload it to the EVENT CAPTURE PATIENT file 
(#721). 

•	 The Spreadsheet application can work with existing Excel files and tab or comma delimited 
files. To see a sample spreadsheet, select ‘custom’ installation type during the EC GUI 
installation process and make sure the “Spreadsheet” checkbox is selected. When the 
installation is finished, you can view two sample spreadsheets in the folder containing the 
application (defaults to C:\Program Files\vista\EC). One contains only data and the other 
contains general layout information of the file. 

•	 Each record in the spreadsheet is validated before being filed in the EVENT CAPTURE 
PATIENT file (#721). Two levels of validation occur. The first level of validation occurs 
within Delphi. Each record is checked for the necessary information. No data will be sent to 
VistA if the Delphi validation is not ‘passed’ for every record in the spreadsheet. After 
passing that level of validation, the RPC broker is called, and each record is sent, one by one, 
to VistA for validation. If an error is found, then the error message is sent back to the Delphi 
application and displayed, and the record is not filed. If no errors are found, then the record is 
filed in the EVENT CAPTURE PATIENT file (#721). This occurs until all records have 
been validated. The records that are filed will be removed from the spreadsheet grid, leaving 
only those records with errors. The error message(s) are displayed in the error message box, 
and you have the opportunity to edit or delete the record(s) before retransmitting.  
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Spreadsheet 

Enter Data via the Event Capture Spreadsheet 

What the User will see 
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Spreadsheet 

Enter Data via the Event Capture Spreadsheet 

Instructions 

1.	 When starting the Spreadsheet Upload, the column headers will be displayed in a default 
order. The default spreadsheet column order can be changed. If you have a spreadsheet with 
a different order, click on the Column Header button (or select the Spreadsheet Options 
menu and click on “Change Column Headers”) to change the order as needed. 

2.	 Help is available for each column in the spreadsheet. Click on any column and then click on 
the Help button . 

3.	 If an error message is displayed in the error message box, simply click on the error message 
and the cell in the grid will be highlighted that most likely caused the error. 

4.	 If more than one provider exists with that name in the spreadsheet, or if a partial match is 
found on the name, then the application will return matching and partial-matching provider 
information (provider name, IEN, specialty, subspecialty, person class) to the error box, and 
you can determine which provider you want and enter the correct name or IEN into the 
spreadsheet as necessary. For example, provider name JONES, DAVID may return provider 
information for JONES, DAVID, JONES, DAVID A and JONES, DAVID B. Provider name 
SMITH, STAN may return information for SMITH, STANLEY and SMITH, STANTON. 

5.	 It has been determined that some inpatient records may need to be uploaded. We handle this 
by checking the patient status for that particular date/time. If it is determined to be an 
inpatient record, then an ‘Inpatient Override’ checkbox appears on the screen, a warning 
message appears in the error message box, and the record is returned for editing by the user. 
At this point, the user has the following options. 
•	 Override the inpatient-warning message by selecting the Inpatient Override checkbox 

and then retransmit. The record will be uploaded as inpatient. 
•	 Change the Encounter date/time and upload it as outpatient. 

6.	 When uploading the spreadsheet and duplicate records are detected, a ‘File Duplicate 
Record(s)’ checkbox appears on the screen. The duplicate records are displayed in the error 
message box. When all records have been processed, if any duplicates exist, the user is 
prompted with a 'File Duplicate Record(s)' check box. Selecting the check box and 
retransmitting, files the duplicate records in the EVENT CAPTURE PATIENT file (#721). 

7.	 Double clicking on a cell in the spreadsheet grid and pressing the delete key will delete the 
contents of that cell only. Clicking once on a cell and then pressing the delete key will delete 
the ENTIRE RECORD. 
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Spreadsheet 

Enter Data via the Event Capture Spreadsheet 

8.	 Column Headers - When starting the spreadsheet upload program, the column headers will 
be displayed in a default order. The column order can be changed at any time (before and 
after transmitting data to VistA). To change the column header order, select ‘Spreadsheet 
Options’, ‘Change Column Headers’. The default column header order is as follows. 

Record number 

Location 

Pat SSN 

Pat LName 

Pat Fname 

DSS Unit Name
 
DSS Unit Num
 
DSS Unit IEN 

Proc Code 

Volume
 
Ordering Sect 

Prov Name or IEN 

Enc Date/Time 

Category
 
Diag Code 

Assoc Clinic 


9.	 Spreadsheet Column Data and associated error messages: 

Record Number 
Each record in the spreadsheet needs a unique record number (during each transmission), i.e., 
1, 2, 3, etc. An error will be generated before VistA validation occurs if this field is blank. If 
the record number is not unique and there are no errors for that record number on the VistA 
side during validation, then there is no problem, and the data will transmit successfully. If the 
record number is not unique and an error has occurred on the VistA side, then the error 
messages will not be properly mapped to the record(s) in error, and you will need to give it a 
unique record number at that point and retransmit the record(s) in error. 

Delphi messages 
Error getting column with Record number 

Record number is a mandatory field 


Location 
The Location number must exist on the INSTITUTION file (#4, ^DIC(4,D0,0)). 

VistA message 
Location not on INSTITUTION file (#4) 
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Spreadsheet 

Enter Data via the Event Capture Spreadsheet 

Pat SSN 
Patient SSN must exist on the PATIENT File (#2, ^DPT). 

If the SSN is shorter than 9 digits, it will be left filled with zeros.  


VistA messages 
No SSN x-ref on PATIENT file (#2) 

No SSN entry on PATIENT file (#2) 

No internal entry on PATIENT file (#2) for SSN x-ref 

SSN does not match SSN on PATIENT file (#2) 


Patient LName and Patient Fname 
Patient last and first name - The patient’s name (last name, first name) must match the name 
on the PATIENT file (#2) for that SSN. 

Delphi messages 
Error getting column with Patient LName 
Patient LName must be at least 2 characters long 

VistA messages 
Patient last name doesn’t match VistA 
Patient first name doesn’t match VistA 

DSS Unit Name 
If this field contains a value, then it must have a “B” cross-reference on the DSS UNIT file 

(#724). 

Note: The DSS Unit name is not required if the DSS Unit IEN or the DSS Number column
 
is filled in. 


VistA message 
Invalid DSS Unit Name 

DSS Unit Number 
This is the Unit Number, found on the DSS UNIT file (#724). If this field contains a value, 

then it must have a “C” cross-reference on the DSS UNIT file (#724).  

Note: The DSS Unit Number is not required if the DSS Unit IEN or the DSS Unit Name is 

filled in. 


VistA message 
Invalid DSS Unit Number 

January 2010 Event Capture V. 2.0 GUI User Manual 51 



  

 

 

 
 

 

 
 

 

 

Spreadsheet 

Enter Data via the Event Capture Spreadsheet 

DSS Unit IEN 
If this field contains a value, then it must exist on the DSS UNIT file (#724). 

Note: The DSS Unit IEN is not required if the DSS Unit Name or the DCM Dept is filled in. 


VistA message 
Invalid DSS Unit IEN 

Proc Code 
This is the procedure/CPT code value (not the description). The National Procedure, Local 
Procedure and CPT code are all valid codes for this column. The procedure/CPT must exist 
on the EC NATIONAL PROCEDURE file (#725) or the CPT file (#81), and the EC Event 
Code Screen must be ‘active’ for the Location, DSS Unit IEN, and Procedure/CPT 
combination. With functionality put in place by the Code Set Versioning project, only CPT 
codes that are active for the date and time of the event will be processed. 

VistA messages 
Procedure or “D” x-ref not on EC NATIONAL PROCEDURE file (#725) 

Procedure invalid for this Location and DSS Unit 

Unable to check for active EC Event Code Screen 


Volume 
The volume must be a number from 1 through 99. 

Delphi error messages 
Error getting column with Volume number 

Volume is a mandatory field 

Volume has a limit of 2 digits 


VistA messages 

Volume must be a number from 1 to 99 

Volume must contain numeric characters only 
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Spreadsheet 

Enter Data via the Event Capture Spreadsheet 

Ordering Section 
This is the name of the Ordering Section. If the user enters an ordering section into the 
spreadsheet, it will be validated against the “B” cross reference in the MEDICAL 
SPECIALTY file (#723). If the user leaves this field blank, the program will derive the 
Ordering Section from DSS UNIT file (#724) using the DSS Unit IEN. It will then be sent to 
the Event Capture filer program. 

VistA message 
Invalid Ordering Section 

Unable to determine Ordering Section 


Prov Name or IEN 
This is the Provider’s last and first name as it appears in the “B” cross reference of the NEW 
PERSON file (#200). If the provider also has a middle initial, then it should be included, i.e. 
‘ECPROVIDER, SEVEN J’. If a partial match is found on the name, the application will 
return the provider information (provider name, IEN, specialty, subspecialty, person class) 
for all options to the error box, and you can then determine which provider they want. The 
Provider must have a “B” cross-reference and exist on the NEW PERSON file (#200) and the 
person class must be ‘active’. 

LASTNAME, FIRSTNAME, or IEN 

VistA messages 
Provider has no B x-ref on NEW PERSON file (#200) 

Unable to determine person class 

Provider does not have an active person class 


Enc Date/Time 
The Encounter Date/Time can be in any valid FileMan format. The ‘seconds’ are optional. 

Examples 
mm/dd/yy @hh:mm:ss 

mm/dd/yyyy @hh:mm:ss 

mm-dd-yy @hh:mm
 
mmddyy @hhmm
 
N, N-1, N-1H, etc. 


VistA message 
Invalid encounter date/time 
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Enter Data via the Event Capture Spreadsheet 

Category 
The Category field can be left blank. If a value is entered, it needs to have a B cross-
reference in the EC CATEGORY file (#726). 

VistA message 
Category "B" x-ref not on EC CATEGORY file (#726) 

Diag Code 
This is the primary diagnosis code value. It must exist on the ICD DIAGNOSIS file (#80). 

With functionality put in place by the Code Set Versioning project, only ICD codes that are 

active for the date and time of the event will be processed. 

Note: The Diagnosis Code is only required for records sent to PCE and will be ignored 

otherwise. 


VistA messages 
Diagnosis code is required for this DSS Unit 

Unable to retrieve Diagnosis IEN 

Diagnosis code is required for this DSS Unit 

Unable to retrieve Diagnosis IEN 


Assoc Clinic 
This is the Associated Clinic name. It must have a “B” cross-reference on the HOSPITAL 
LOCATION file (#44), be of type “C” (clinic), and be ‘active’ for that encounter date. The 
Associated Clinic must have conforming stop codes to be selectable. 
Note: The Associated Clinic is only required for records sent to PCE and will be ignored 
otherwise. 

VistA messages 
Associated Clinic is required for this DSS Unit 

Assoc Clin "B" x-ref not found on HOSPITAL LOCATION file (#44) 

Assoc Clin not found on HOSPITAL LOCATION file (#44) 

Associated Clinic must be of type "C" (clinic) 

Associated Clinic inactive for this encounter date 
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Spreadsheet 

Enter Data via the Event Capture Spreadsheet 

10. Other Logic: 

DSS Unit IEN 
The DSS Unit IEN is obtained by checking the DSS Unit IEN field, the DCM Dept field, and 
then the DSS Unit Name field. Only one is needed. If any of the three columns contain 
erroneous data, an error message will be generated and the record will not be filed. 

Send to PCE 
Using the DSS Unit, the application determines if the record should be sent to PCE. If so, the 
application then validates the Associated Clinic and Diagnosis Code. If not, then these two 
columns will be ignored. 

Instructions 

1.	 Click on the Spreadsheet button in the Main Menu. 
2.	 Click on Open in the File menu to display a list of Excel files from which to choose.  

Find Excel file and click open. A list of patient data will appear with column headings for 
Record Number, Station Number, Patient first and last name, SSN, DSS Unit Number and 
IEN, DCM Department, Procedure and Diagnosis Code, Volume, Service, Provider first and 
last name, Encounter Date/Time, and Associated Clinic. 
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Enter Data via the Event Capture Spreadsheet 

Note: The default spreadsheet column order can be changed.
 

If you have a spreadsheet with a different order, click on the Column Header button 
 (or 
select the Spreadsheet Options menu and click on Change Column Headers) to change the 
order as needed. 
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Enter Data via the Event Capture Spreadsheet 

You may change the order of the columns by highlighting the column heading in the list and 
clicking on the Move Up and Move Down Buttons. Continue to change the column heading 
order until it matches the spreadsheet being used, then upload the spreadsheet. 
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Spreadsheet 

Enter Data via the Event Capture Spreadsheet 

Note: At this point, you may change the Duplicate Threshold value through the Spreadsheet 
Options drop down menu by selecting Change Duplicate Threshold. 

3.	 Click on “Transmit EC Data to VistA” in the EC Transmission menu or the Update Records 
to VistA button  in the toolbar. The data is validated and uploaded and error messages are 
returned for those records containing errors. 
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Spreadsheet 

Enter Data via the Event Capture Spreadsheet 

Check for Duplicate Records 

The Spreadsheet checks for duplicate records, based on the Location (Station number), Patient 
SSN, DSS Unit, and Procedure Date/Time. The duplicate records are displayed below the 
spreadsheet. When the user-defined threshold of duplicate records is reached, a message box will 
display with the options of Continue, Change, and Abort. 

•	 Continue: resets the counter and resumes processing of records. 

•	 Change: You have the option of changing the Duplicate Threshold default value from 10 
to a user-defined number. The Duplicate Threshold value can be changed two ways: 

From the Spreadsheet Options drop down menu, select Change Duplicate Threshold 
or 
When the threshold is reached and the Duplicate Record Threshold Reached window is 
displayed, click the Change button. 

• Abort: terminates the upload process. 

Message displayed when the upload process is aborted… 
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Spreadsheet 

Enter Data via the Event Capture Spreadsheet 

Records with errors can be corrected/deleted and the spreadsheet retransmitted.  
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Spreadsheet 

Enter Data via the Event Capture Spreadsheet 

When the data is transmitted, only those records with errors will be returned.  
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Spreadsheet 

Enter Data via the Event Capture Spreadsheet 

Any records filed into the EVENT CAPTURE PATIENT file (#721) will not appear in the 
spreadsheet grid after transmission. A message will appear in the status bar at the bottom of the 
screen with a count of successfully transmitted records and a count of how many error messages 
were generated. 
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Reports 

Preview and print selected reports 

The following reports are available: 

Patient Summary Report 
DSS Unit Activity Report 
DSS Unit Workload Report 
Provider Summary Report 
Ordering Section Summary Report 
Provider (1-7) Summary Report 
PCE Data Summary Report 
Inactive Person Class Report 
Procedure Reason Report 
ECS Records Failing Transmission to PCE Report 
National / Local Procedure Report 
Category Report 
Print Category and Procedure Summary (Report) 
Event Code Screens with CPT Codes Report 
National / Local Procedure Codes with Inactive CPT Codes Report 
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Reports 

Patient Summary Report 

Before the User Starts 

•	 This report is designed for a 132-column format. 
•	 With functionality put in place by the Code Set Versioning project, CPT codes, five-

character EC National Codes (when applicable), CPT modifiers and their associated 
descriptions are reflective of the date the event occurred. 

What the User will see 

•	 After previewing the report, you will have the option to print or cancel the report. 

Instructions 

1. Select a patient. 
2. Enter a date range. 
3. Choose whether to include Procedure Reasons in the output. 
4. Print or preview the report. 
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Reports 

Patient Summary Report 

Example 
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Reports 

DSS Unit Activity Report 

Before the User Starts 

• If more than one location has been set up, you will need to choose one or all locations. 

What the User will see 

• After previewing the report, you will have the option to print or cancel the report. 

Instructions 

1. Select one or all location(s). 
2. Select one or all DSS Unit(s). 
3. Choose the report sort method. 
4. Enter a date range or accept the default dates. 
5. Print or preview the report. 
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Reports 

DSS Unit Activity Report 

Example 
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Reports 

DSS Unit Workload Report 

Before the User Starts 

•	 This option replaces the AMIS Summary - Event Capture option. 
•	 With functionality put in place by the Code Set Versioning project, CPT codes, five-

character EC National Codes (when applicable), CPT modifiers and their associated 
descriptions are reflective of the date the event occurred. 

What the User will see 

•	 After previewing the report, you will have the option to print or cancel the report. 

Instructions 

1.	 Select one or all location(s). 
2.	 Select one or all DSS Unit (s). 
3.	 Enter a date range. 
4.	 Print or preview the report. 
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Reports 

DSS Unit Workload Report 

Example 
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Reports 

Provider Summary Report 

Before the User Starts 

•	 Locations, DSS Units, categories, procedures, and procedure reasons must be defined before 
generating this report. 

•	 With functionality put in place by the Code Set Versioning project, CPT codes, five-
character EC National Codes (when applicable), CPT modifiers and their associated 
descriptions are reflective of the date the event occurred . 

What the User will see 

•	 After previewing the report, you will have the option to print or cancel the report. 

Instructions 

1.	 Select one or all location(s). 
2.	 Select one or all DSS Unit(s). 
3.	 Enter a date range. 
4.	 Print or preview the report. 
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Reports 

Provider Summary Report 

Example 
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Reports 

Ordering Section Summary Report 

Before the User Starts 

•	 This report is designed to use a 132-column format. 
•	 With functionality put in place by the Code Set Versioning project, CPT codes, five-

character EC National Codes (when applicable), CPT modifiers and their associated 
descriptions are reflective of the date the event occurred. 

What the User will see 

•	 After previewing the report, you will have the option to print or cancel the report. 

Instructions 

1.	 Select an ordering section. 
2.	 Enter a date range. 
3.	 Select whether to print for all locations or a specific location. 
4.	 Select whether to print for all DSS units or a specific DSS unit. 
5.	 Print or preview the report. 
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Reports 

Ordering Section Summary Report 

Example 
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Reports 

Provider (1-7) Summary Report 

Before the User Starts 

•	 This report is designed to use a 132-column format. 
•	 With functionality put in place by the Code Set Versioning project, CPT codes, five-

character EC National Codes (when applicable), CPT modifiers and their associated 
descriptions are reflective of the date the event occurred. 

•	 Provides the ability to view up to seven provider numbers for providers within a 
Location/DSS Unit. 

•	 Summarizes the workload of providers for a selected date showing how many times a 
specific procedure was performed on a patient with the selected provider as Provider 1, 
Provider 2, through Provider 7. 

What the User will see 

•	 After previewing the report, you will have the option to print or cancel the report. 
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Reports 

Provider (1-7) Summary Report 

Instructions 

1. Enter the name of a provider. 
2. Choose whether to include Procedure Reasons in the output. 
3. Enter a date range. 
4. Print or preview the report. 
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Reports 

Provider (1-7) Summary Report 

Example 
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Reports 

PCE Data Summary Report 

Before the User Start 

•	 This report is designed to use a 132-column format. 
•	 With functionality put in place by the Code Set Versioning project, CPT codes, five-

character EC National Codes (when applicable), CPT modifiers, diagnosis codes and their 
associated descriptions are reflective of the date the event occurred. 

What the User will see 

•	 After previewing the report, you will have the option to print or cancel the report. 

Instructions 

1.	 Select a patient. 
2.	 Enter a start and end date. 
3.	 Print or preview the report. 
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Reports 

PCE Data Summary Report 

Example 
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Reports 

Inactive Person Class Report 

Before the User Start 

•	 This report shows providers who do not have a Person Class specified in the NEW PERSON 
file (#200) or who does not have an active Person Class in the NEW PERSON file (#200) for 
the date of the procedure. 

What the User will see 

•	 After previewing the report, you will have the option to print or cancel the report. 

Instructions 

1.	 Enter beginning and ending dates. 
2.	 Select whether to sort the output by patient or provider. 
3.	 Print or preview the report. 
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Reports 

Inactive Person Class Report 

Example 
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Reports 

Procedure Reason Report 

Before the User Starts 

•	 Locations, DSS Units, procedures, and procedure reasons must be defined before using this 
option. 

•	 With functionality put in place by the Code Set Versioning project, CPT codes, five-
character EC National Codes (when applicable), CPT modifiers, diagnosis codes and their 
associated descriptions are reflective of the date the event occurred. 

What the User will see 

•	 After previewing the report, you will have the option to print or cancel the report. 

Instructions 

1.	 Select one or all locations. 
2.	 Select one/many/all DSS Units. 
3.	 Select one/many/all procedure reasons. 
4.	 Enter beginning and ending dates. 
5.	 Print or preview the report. 
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Reports 

Procedure Reason Report 

Example 
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Reports 

ECS Records Failing Transmission to PCE Report 

Before the User Starts 

•	 Locations, DSS Units, procedures, five-character EC National Codes (when applicable), and 
categories must be defined before using this option. 

What the User will see 

•	 After previewing the report, you will have the option to print or cancel the report. 

Instructions 

1.	 Select the From and Through dates. 
2.	 Print or preview the report. 
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Reports 

ECS Records Failing Transmission to PCE Report 

Example 
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Reports 

National/Local Procedure Report 

Before the User Starts 

•	 Use the Procedure - Add or Update Local Procedures option to create local procedures 
before using this option. 

•	 This report is accessible to Management users only. For users without the Management 
Security key (ECMGR), this report will not appear. 

What the User will see 

•	 After previewing the report, you will have the option to print or cancel the report. 

Instructions 

Active Procedures 

1.	 Click the Active button. 
2.	 Choose preferred report - national, local, or both. 
3.	 Choose the sort method – procedure or national code. 
4.	 Print or preview the report. 
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Reports 

National/Local Procedure Report 

Inactive Procedures 

1. Click the Inactive button. 
2. Print or preview the report. 

Note: If the report is marked as Inactive, the preferred report and sort method will be grayed 
out. The output includes procedure name, national number, and CPT. 
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Reports 

National/Local Procedure Report 

Example - Active 
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Reports 

National/Local Procedure Report 

Example - Inactive 
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Reports 

Category Report 

Before the User Starts 

•	 Use the Category - Add or Update Categories option to create categories before using this 
option. 

•	 This report is accessible to Management users only. For users without the Management 
Security key (ECMGR), this report will not appear. 

What the User will see 

•	 After previewing the report, you will have the option to print or cancel the report 

Instructions 

1.	 Choose a status of Active, Inactive, or Both. 
2.	 Print or preview the report. 
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Reports 

Category Report 

Example - Active 

Example - Inactive 
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Reports 

Category Report 

Example – Both Active and Inactive 
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Reports 

Print Category and Procedure Summary (Report) 

Before the User Starts 

•	 Use the DSS Unit - Add or Update DSS Units option to create DSS Units categories before 
using this option. 

•	 Use the Category - Add or Update Categories option to create categories before using this 
option. 

•	 Use the Procedure - Add or Update Local Procedures option to create procedures before 
using this option. 

•	 This option generates a list of Event Code Screens. 
•	 You are prompted for categories only if the Event Code Screen uses categories to group 

procedures. 
•	 This report is accessible to Management users only. For users without the Management 

Security key (ECMGR), this report will not appear. 

What the User will see 

•	 After previewing the report, you will have the option to print or cancel the report. 
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Reports 

Print Category and Procedure Summary (Report) 

Instructions 

1.	 Select one or all locations from the pull down menu. You may choose to print Active, 
Inactive, or Both (Active and Inactive) EC Code Screens. 

2. Select a DSS Unit or select All from the pull down menu. 

January 2010 	 Event Capture V. 2.0 GUI User Manual 93 



 

  

 

 

 
 

 
 

 
 

 
 

Reports 

Print Category and Procedure Summary (Report) 

If All is selected for the DSS Unit, the Category will also become All. 

3. Select a Category from the pull down menu if a DSS Unit was selected. 

4. Print or preview the report. 
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Reports 

Print Category and Procedure Summary (Report) 

Example 
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Reports 

Event Code Screens with CPT Codes Report 

This option allows you to print/display event code screens with active/inactive/both CPT codes 
for all or a specific DSS Unit. 

The output includes the following. 

Run Date 
Location 
Service 
DSS Unit 
Category (if applicable) 
Procedure Name 
National Number  
CPT Code - Inactive CPT codes are flagged with an *I* when printing both active and 
inactive codes 

Before the User Starts 

• Users must have the ECMGR key to access this report. 

What the User will see 

• After previewing the report, you will have the option to print or cancel the report. 

Instructions 

1. Select one or all Location(s). 
2. Select one or all DSS Unit(s) 
3. Select a category, if available. If All DSS Units are selected, Category will be All. 
4. Select to view Active, Inactive, or both Active and Inactive CPT codes. 
5. Print or preview the report. 
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Reports 

Event Code Screens with CPT Codes Report 

Example 
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Reports 

National/Local Procedure Codes with Inactive CPT Codes Report 

This report provides a list of National and Local Procedure Codes with inactive CPT codes from 
EC NATIONAL PROCEDURE file (#725). 

The output includes the following. 

Run Date 

National Number  

National Name
 
CPT Code 

Inactive Date 


Before the User Starts 

• Users must have the ECMGR key to access this report. 

What the User will see 

• After previewing the report, you will have the option to print or cancel the report. 

Instructions 

1. Select the report. No further selection criteria is required. 
2. Print or preview the report. 
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Reports 

National/Local Procedure Codes with Inactive CPT Codes Report 

Example 
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Reports 
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Management Menu 

Perform Event Capture Management Functions 

Location – Update Location Information 
DSS Unit – Add or Update DSS Units 
Access by User – Grant Access to DSS Units by User 
Category – Add or Update Categories 
Procedure – Add or Update Local Procedures 
Event Code Screen – Add or Update Event Code Screens 
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Management Menu 

Location - Update Location Information 

Before the User starts 

•	 Location selected must be in the INSTITUTION file (#4). 
•	 Locations must be created with this option before you can establish DSS Units. 
•	 No further options are functional until you create an Event Capture location. 

What the user will see 

•	 Selecting the Location - Update Location Information option opens a screen that displays all 
the known location names, their State, Facility Type, Station Number, and Current Status in 
matrix form. You may adjust the size of the columns of the matrix. 

•	 From the first screen, select a location. 

• After selecting a location, a second screen will appear where you may create the location as 
current or remove the selected location.  

Event Capture V. 2.0 GUI User Manual	 January 2010 102 



 

 

 

 

 

 
 

 

 

 
 

Management Menu 

Location – Update Location Information 

Sort Function 

The rows may be sorted by using the Sort Menu or by clicking on the column header. 

Instructions 

1. To create a current location, click the checkbox labeled “Create as current Event Capture 
location” and click the OK button. The location is flagged as active for use in the Event 
Capture software. 

2. To remove a current location, click the checkbox labeled “Remove as current Event Capture 
location” and click the OK button. The location is flagged as inactive for use in the Event 
Capture software. 
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Management Menu 

Location – Update Location Information 

Event Capture V. 2.0 GUI User Manual January 2010 104 



 

 

 

 
 

 

 
 

 
 

 

 
 
 

 

Management Menu 

DSS Unit - Add or Update DSS Units 

Before the User Starts 

•	 Use the Location - Update Location Information option to create an Event Capture location 
before using this option. 

•	 You will be prompted to enter an Associated Stop Code only if the "Send to PCE" flag is set 
to NO or NULL. 

•	 No further options are functional until DSS Units are created. 

What the User will see 

•	 After selecting DSS Unit from the Management Menu, the first screen will display a list of 
DSS Units. You may choose to update an existing DSS Unit or add a new one by clicking on 
the Update button or Add button. 

•	 The PCE column reflects if workload is set to pass to PCE. Values include:  ALL – Send all 
records; Outpatient – Send outpatient only; No – Send no records. 

•	 The screen contains a column for Unit IEN. 
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Management Menu 

•	 The header for the DSS Number column now reads DSS Dept. 
•	 Find buttons, search string, and results popup provide search capability by DSS Unit Name, 

DSS Dept., and Unit IEN. You can type a partial search string, press find (binoculars icon), 
and the screen will position to the first entry matching your search criteria. 

•	 You may choose to display active units, inactive units, or all units. 
•	 The Print button allows you to print the report and the export button allows you to export the 

data to an Excel spreadsheet. The print and export functions are available only on the 
Management Menu Screen – DSS Units. Examples of these screens follow. 

Print 
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Management Menu 

Export 
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Management Menu 

DSS Unit - Add or Update DSS Units 

•	 The second screen allows you to add a new DSS Unit or update an existing DSS Unit. The 
second screen will appear as follows. 
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Management Menu 

DSS Unit - Add or Update DSS Units 

• Enter the following data for each DSS Unit created. 

Element Name Description 
DSS Unit Name The name of the DSS Unit being created 
DSS Unit Number The number to identify this DSS unit locally at the user’s site (1 to 14 

characters) - The same DSS Unit number can be used for more than one 
DSS Unit 

Service The service associated with this DSS Unit - from the 
SERVICE/SECTION file (#49) 

Medical Specialty The medical specialty associated with this DSS Unit - from the 
MEDICAL SPECIALTY file (#723) 

Cost Center The cost center associated with this DSS Unit - from the COST 
CENTER file (#420.1). Cost centers are defined in MP4-Part V, 
Appendix B of the Fiscal Service cost manuals. 

Default Date/Time NOW – The current date and time will populate during data entry 
NONE – The date and time will not be filled in during data entry. The 
user will be required to enter it. 

Allow Category Use (Y/N) YES – Use categories to group procedures during data entry 
NO – Do not use categories to group procedures during data entry 

DSS Unit Status Active - Lists Active Event Code Screens 
Inactive - Lists Inactive Event Code Screens 

Event Code Screens Reactivate 
Remain Inactive 

Send to PCE Defines the method used to send the user’s data to PCE for the DSS 
Unit the user is creating. 
All Records Send All Records 
Outpatient Only  Send Outpatient Only 
No Records Send No Records 

Associated Stop Code Select the DSS ID (Clinic Stop Code) associated with this DSS Unit. Be 
sure to select an active DSS ID. 

Note: In the second screen, the status defaults to “Active.” The Allow Category Use field 
defaults to “No”, but will allow you to select “Yes.” If you set the Send to PCE option to 
“No Records”, it will enable the Associated Stop Code field. You may search for Associated 
Stop Code by description or code. Both description and code will be displayed. If you set the 
Send to PCE option to “All Record” or “Outpatient Only”, disable the Associated Stop Code 
field. All other options have the capability to be changed from the previous default. 

Instructions 

1 To add a DSS Unit: 
• Click on the Add button. 
• Enter a DSS Unit Name.  
• Enter a DSS Unit Number.  
• Select a Service from the Service drop down box.  
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Management Menu 

DSS Unit - Add or Update DSS Units 

• Select a Medical Specialty from the Medical Specialty drop down box.  
• Select a Cost Center from the Cost Center drop down box. 
• Choose the Date/Time Default. 
• Choose whether or not to Allow Category Use. 
• Choose which records will be Sent to PCE. 
• When selections are complete, click OK. 
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Management Menu 

DSS Unit - Add or Update DSS Units 

2. 	 To update a DSS Unit: 

Select a DSS Unit from the list of DSS Units and click on the Update option button. 
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Management Menu 

DSS Unit - Add or Update DSS Units 

A second screen will appear. This screen allows you to update the DSS Unit name, DSS Unit 
Number, Service, Medical Specialty, Default Date and Time, Allow Category Use, DSS 
Status, Event Code Screens status, and Send to PCE. 
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Management Menu 

DSS Unit - Add or Update DSS Units 

DSS Status may be Active or Inactive. Note that the Event Code Screen Options are different 
when Inactive is chosen for DSS Status 

 Original Active Status    Original Inactive Status 

When the DSS Status is changed, the Event Code Screens options also change. 

     Change from Active to Inactive Status      Change from Inactive to Active Status 

User may choose to Retain (keep active) or Inactivate a DSS Unit that was active. 

User may choose to Reactivate a DSS Unit that was inactive or choose to have it Remain 
Inactive. 

When update is complete, click OK. 
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Management Menu 

DSS Unit - Add or Update DSS Units 

From the second DSS Unit - Add or Update DSS Units screen, you have the option to go to a 
third screen to give specific users access to the DSS Units selected. From the second screen, 
click on the Access button at the bottom of the screen.  

•	 The Grant Access to DSS Unit Screen has Include and Exclude fields. 
•	 At the top of each of the Include and Exclude fields is a search field which allows you to 

key in beginning characters of the last name. Scroll through the list to search for a last 
name. 

•	 The Exclude field contains the set-up for all active users in VistA at the site. 
•	 To give or take away access to a specific DSS unit, the management user must move the 

user’s names from the Included and Excluded boxes by highlighting the name and 
pressing the Include or Exclude button. The name will move into the desired box. 
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Management Menu 

Access by User - Grant Access to DSS Units by User 

Before the User starts 

•	 NOTE:  Use extreme caution when utilizing this option. Removing access to a specified 
DSS Unit for all users and inactivating the DSS Unit is not recommended without the 
permission of the associated service.  

•	 Contact each service for a list of its Event Capture users and the DSS Units for which they 
enter data. 

•	 You must have access to DSS Units before you can begin entering procedure data. 

Access can be provided to all DSS Units by assigning the ECALLU security key to a specified 
user (normally the DSS Manager or designee) using the Allocation of Security Keys option in the 
Key Management Menu under the Menu Management Menu. This option cannot be used to 
remove access to DSS Units for users who hold the ECALLU security key. 

Instructions 

To Assign User Access to DSS Units 

1.	 Click on the Access by User - Grant Access to DSS Units by User button. 
2.	 When the screen opens, a list of users appears at the top of the box. Select a user. 
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Management Menu 

Access by User - Grant Access to DSS Units by User 

3.	 Select the names of the DSS Unit(s) to be allocated by highlighting the particular unit and 
clicking on the Include button. 

4. Click the Apply button to apply the changes and continue working or click the OK button to 
apply the changes the exit the screen. 
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Management Menu 

Category - Add or Update Categories 

Before the User Starts 

•	 If the DSS Units at your site are defined for use without categories, ignore this option. 
•	 You cannot delete categories but can use this option to inactivate or reactivate them. 

What the User will see 

•	 After selecting Category – Add or Update Categories from the Management Menu, the first 
window displays a list of Category Names, the Date created, and the Inactivation Date. 

• The second screen allows you to add a Category or to update a selected Category. The 
second screen contains fields called Category Name and Status. 
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Management Menu 

Category - Add or Update Categories 

Instructions 

1. 	 To add a new local category: 
•	 After clicking on the Category - Add or Update Categories button from the Management 

Menu, click on the Add button on the toolbar or in the Edit menu. The Status field 
defaults to “Active”. 

•	 Enter the new local category name. 
•	 Click OK. 

2. 	 To update an existing local category: 
•	 After clicking on the Category - Add or Update Categories button from the Management 

Menu, highlight a particular category from the list of categories. 
•	 Click on the category to activate status field. The Status field displays what the current 

status is for the category. 
•	 Change the category to its new status by clicking Active or Inactive. The results of this 

action will appear on the first screen. 
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Management Menu 

Category - Add or Update Categories 

This screen shows the New Category name and Create Date. The Inactivation Date for the 
inactivated category is also shown. 
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Management Menu 

Procedure - Add or Update Local Procedures 

Before the User Starts 

•	 You might want to use the National/Local Procedure Report option on the Reports menu of 
the Event Capture Main Menu to print a list of procedures with their associated CPT codes 
before using this option. This report can be lengthy if it includes national procedures. You 
should queue it to print to a device during non-peak hours. 

•	 You must enter an associated CPT code to pass local procedures to the PCE software. 
•	 A local procedure code number is required for any new local procedure.  
•	 The local number code must be five characters in length, starting with an uppercase alpha 

character, followed by four alpha or numeric characters. 
•	 With functionality put in place by the Code Set Versioning project, only active CPT codes 

are made available, and are based on the date a local procedure is added. 

What the User will see 

•	 After selecting Procedure - Add or Update Local Procedures from the Management Menu, 
the first screen displays a list of Local Procedure Names, Procedure Number, CPT Code, and 
CPT Description and Active Status. 
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Management Menu 

Procedure - Add or Update Local Procedures 

•	 The second screen allows you to add a Local Procedure or update a selected Local 
Procedure. The second screen contains the following fields:  Procedure Name, Procedure 
Number, CPT Code, and Description and Status.  

•	 You cannot delete procedures but can use this option to inactivate or reactivate them. 
•	 The CPT Code and Description field contains CPT Code look-up functionality. This allows 

you to search for a CPT Code by the code, a part of the code, or a part of the description. 
•	 Choose whether you want to print a list of the user’s current local procedures. 
•	 When adding a Local Procedure Code, the system checks it against the National Procedure 

code format to prevent a Local Code that is already assigned as a National Code from being 
added. A message is displayed and the Local Code is prevented from being added. 
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Management Menu 

Procedure - Add or Update Local Procedures 

Instructions 

1. To add a new local procedure: 
• Click on the Add button in the Edit menu or on the toolbar. 
• Enter the new local procedure name. 
• Enter the local procedure code number. 
• Enter the CPT code if you want the data passed to the PCE software. 

The Procedures list is updated after adding a local procedure. 
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Management Menu 

Procedure - Add or Update Local Procedures 

2. 	 To update an existing local procedure: 
•	 Highlight and click the original local procedure name. 
•	 At the subsequent prompts, edit the procedure name, national number, status, and/or CPT 

code. 

The Procedures list is updated after editing a procedure. 
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Management Menu 

Event Code Screen - Add or Update Event Code Screens 

Before the User Starts 

•	 Use the Location - Update Location Information option to create an Event Capture location 
before using this option. 

•	 Use the DSS Unit - Add or Update DSS Units option to establish DSS Units before using this 
option. 

•	 Event Code screens must be defined before entering any Event Capture data. 
•	 You will be prompted for a category only if the Event Code screen uses categories to group 

procedures. 
•	 You must define an active associated clinic and CPT code to pass Event Code procedures to 

PCE. 
•	 With functionality put in place by the Code Set Versioning project, only active CPT codes 

will be selectable and will be based on the date the event code screen is being set-up. 
•	 The Event Code screen allows the characters “/” and” –“ to be entered in the search field. 
•	 The Associated Clinic on the Event Code screen is no longer auto-populated. 

What the User will see 

•	 After selecting Event Code Screen - Add or Update Event Code Screens from the 
Management Menu, the first screen displays a drop down box of DSS Units with their 
corresponding Categories and Procedures, and Locations. 
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Management Menu 

Event Code Screen – Add or Update Event Code Screens 

•	 Select a DSS Unit to display the Event Code Screen data. Columns include Synonym, 
Procedure, Location, Category, and Status. 
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Management Menu 

Event Code Screen – Add or Update Event Code Screens 

•	 Double click on an event code to open the Update Event Code Screen where you can add an 
Event Code to update a selected DSS Unit. The Update Event Code Screen contains fields 
called DSS Unit, Category, Location, Procedure, Status, Procedure Synonym, Default 
Volume, Default Associated Clinic, Ask Reasons, and Reasons box. The Reason Box 
includes buttons for New Reason, Exclude, and Include. 

Note:  You will not be able to edit the DSS Unit, Category, Procedure, or Location fields 
from this screen. 
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Management Menu 

Event Code Screen – Add or Update Event Code Screens 

•	 You may find and select an Associated Clinic. The look-up displays only active locations in 
the HOSPITAL LOCATION file (#44) whose type is “C” (clinic) and is a “count” clinic. In 
addition, if an Associated Clinic has non-conforming stop codes, the clinic will not be 
selectable. 

The following instructions and example assume that the user wants the specified DSS Unit to 
Send Data to PCE. 

Instructions 

To add an Event Code Screen 

1.	 After selecting a DSS Unit from the drop down box, click the Add button in the toolbar or in 
the Edit menu.  

2.	 At the appropriate drop boxes select the DSS unit, Category (if applicable, otherwise grayed 
out), Location (one/many/all), Procedure, Procedure Synonym, Status, Default Volume, 
Default Associated Clinic, Ask Reasons, and Reasons (only applicable if Ask Reasons box is 
checked Yes). 

3.	 Click OK. 
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Management Menu 

Event Code Screen – Add or Update Event Code Screens 
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Management Menu 

Event Code Screen – Add or Update Event Code Screens 

To Update an Event Code Screen 

1.	 Select a DSS Unit from the drop down box.  
2.	 Click on an Event Code Screen from the list of event code screens for a particular DSS Unit.  
3.	 In the second screen, update the Status, Procedure Synonym, Default Volume, Default 

Associated Clinic, Ask Reasons, and Reasons. 
4.	 Click OK. 
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Glossary 

Associated Stop Code 

Category 

Cost Center 

Conforming Clinics 

Count Clinic 

CPT code 

CPT Modifier 

CSV 

The DSS Identifier (stop code) that most closely 
represents the DSS Unit workload. 

Category provides Event Capture a common level 
to group associated procedures. Multiple procedures 
can be defined for each category. 

Cost Center reveals which service is using this DSS 
Unit. Cost Centers are defined in detail in MP4-Part 
V, Appendix B of the Fiscal service cost manuals. 

Clinics that have stop codes in compliance with 
their restriction types. Stop codes are used in 
accordance to their assigned restriction types. Stops 
codes with restriction type 'P' can only be used in 
the primary stop code position. Stop codes with 
restriction type 'S' can only be used in the secondary 
stop code position. Stop codes with restriction type 
'E' can be used in either the primary or secondary 
stop code position. 

A clinic for which workload entered is credited. 

Current Procedural Terminology code 

CPT modifiers provide the ability to refine CPT 
procedure codes to better reflect procedures 
performed. 

Code Set Versioning 
The Health Information Portability and 
Accountability Act (HIPAA) mandated that 
applications using CPT codes, CPT modifiers, and 
diagnosis codes should allow users to select codes 
based upon a date that an event occurred. 
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Glossary 

DSS Unit A DSS Unit (Decision Support System Unit) 
defines the lowest level segment used for tracking 
hospital resources. These units can be a small work 
unit within a service or a large division within a 
service. Management at each facility is responsible 
for tailoring the DSS Units to fit its resource/cost 
reporting. 

DSS Unit Number This code is used for additional identification of 
DSS Units. 

Event Capture Software designed to provide management tools 
necessary in tracking procedures not entered in 
other VistA packages. 

Event Code Screen Event code screens are unique combinations of 
location, DSS Unit, category, and procedure that 
define patient procedures. 

GUI Graphical User Interface 

ICD-9 International Classification of Diseases (of the 
World Health Organization) codes 

Location Initializing the user site as a location, the Event 
Capture software recognizes the user facility as a 
valid location to enter Event Capture data. 

MAS Acronym for Medical Administration Service, 
which is now Patient Information Management 
System (PIMS). 

Non-conforming Clinics Clinics with stop codes that do not comply with the 
assigned stop code restriction types of P=Primary, 
S=Secondary and E=Either. 

Non-count Clinic A clinic for which there is no workload credited. 

Ordering Section The medical section ordering the patient’s 
procedure. 

Parent Service The controlling service for a DSS Unit. 

PCE Patient Care Encounter 
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Glossary 

PIMS Patient Information Management System formerly 
Medical Administration Service (MAS). 

Procedure 	 A specific function performed on, or service 
provided to, a patient. Multiple procedures can be 
associated with a single category. 

Procedure Reason 	 A method of generically grouping patient 
procedures. 

Provider 	 The provider of care performing the procedure. This 
provider can be a doctor, nurse, technician, or any 
designated team of medical professionals. 

T&TC 	 508 Accessibility Testing and Training Center 

Volume	 Volume is associated with the number of 
procedures performed. This field can also be used to 
track time actually spent performing the procedures. 

VistA	 Veterans Health Information Systems and 
Technology Architecture 
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Appendix A – Synchronizing ECS with VistA Scheduling 
and PCE at the User’s Site 

Operations and Management (10N) has mandated that all clinical appointments including walk-
ins be scheduled in VistA Scheduling using count clinics. Surgery, Laboratory, and Radiology 
Services feed PCE and NPCD directly from their respective VistA packages and must be 
scheduled with non-count clinics to avoid double-counting. ECS reporting is not used for these 
services. 

Non-clinical appointments such as scheduling transportation resources can continue to use non-
count clinics. 

DSS site teams and clinical staff using ECS reporting must adhere to the following instructions 
for clinical appointments to ensure coordination with VistA Scheduling and PCE. 

1.	 Create a count clinic in VistA Scheduling for scheduling purposes. 
2.	 Associate this clinic with the Event Code Screen and DSS Unit using the Event Code Screen – 

Add or Update Event Code Screens option in the Management Menu of the Event Capture 
software. Event Capture uses the Stop Code of the associated clinic to pass workload data to 
PCE. By passing data from Event Capture to PCE, the user will also be sending the data to 
Austin where it is filed in the National Patient Care Database (NPCD). (See Appendix B.) 

3.	 In DSS do not cost the clinic appointment product. Send it to a DSS statistics department. 
4.	 When recording workload in ECS, ensure the ECS Procedure Date/Time matches the 

date/time of the scheduled appointment. Complete the required encounter information to 
close out the encounter. 

Coordinate and review the above with clinical and administrative staff who use Event Capture as 
well as with Scheduling and PIMS staff. 
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Appendix B - Summary of the PCE Filing Process 

Follow these steps to define an associated clinic for each event code screen that has DSS Units 
marked to send data to PCE. The options mentioned can found in the Event Capture 
Management Menu. 

1.	 Use the DSS Unit – Add or Update DSS Units option to update the SEND TO PCE 
information for each DSS unit.  

2.	 Use the Event Code Screen – Add or Update Event Code Screens option to create new event 
code screens or to modify existing event code screens. 

The DATE/TIME OF PROCEDURE field (#2) of the EVENT CAPTURE PATIENT file (#721) 
requires the entry of both date and time as part of every procedure date. 

Users must provide the following information for each procedure during data entry. 

•	 ICD-9 Diagnosis Code 
•	 If the selected patient has multiple eligibilities, users will be prompted to select the eligibility 

that applies to the specified procedure. The PRIMARY eligibility is displayed as the default. 
•	 A response to the classification questions for patient procedures is required only if they apply 

to the patient. 
•	 If a procedure is associated with a CPT code, then users will be prompted to enter CPT 

modifiers. 
•	 Associated Clinic 

After the PCE-related prompts are answered, all appropriate patient records are formatted to file 
the data with PCE. This formatted data string is stored in the PCE DATA FEED field (#30) of 
the EVENT CAPTURE PATIENT file (#721). The flag to file this record is then set in the 
SEND TO PCE field (#31) of the EVENT CAPTURE PATIENT file (#721). 
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